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1 Introduction

1.1 Purpose

The purpose of this document is to describe SD / SDIO Host Controller 3.0. IP Integration
details.

1.2 Reference Document
e |P data sheet

1.3 Overview

SD/SDIO Host Controller interfaces the Microblaze through AXI4 bus and MiG Controller
through AXI memory mapped interface, enabling the data transfers between each other.
Microblaze IP will send the response to the SD host depending on the command issued and also
communicates with the MIG controller for Data read & write.

1.4 Acronyms and Abbreviations
Table 1: Acronyms & Abbreviations

Term Meaning
FPGA Field Programmable Gate Array
GPIO General purpose input output
FMC FPGA Mezzanine Card
LUT Look Up Table
10 Input and Output
FF Flip Flop
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2 IP Configuration and Instantiation

2.1 Example design
The SD/SDIO host controller IP example design mainly consists of

1. Microblaze soft core: User can provide the inputs to run the different tests using the bare
metal code running in the Microblaze. This will pass the different control signals to SD
host controller based on the user selection.

2. SD/SDIO Host Controller IP: SD host controller IP takes the command given from the
microblaze soft core to the register set and with the ADMA the read and write operation
will happen from and to the SD Card.

2.2 1P Configuration

The register set, ADMA configuration , tuning block , command and data path files are pre
synthesized. After synthesis the post synthesis file i.e., sd_host.edn file is instantiated in the
design as shown in the Figure 1 . The SD Host controller with other files like the sd_host.edn
file, sd_host stub file, axi4_lite interface and the AXI memory mapped interface wrapper files
are added to make a user configured IP.

Sources ? 00 X
Q = ¢ + o
~ . Design Sources (2 &
~ @ 5 sd_host_controller (sd_host_controllery) (5)
@ =d_host_inst: sd_host(sd_hosty)
sd_host_inst: sd_host (sd_hostedn)

® axid_native : axid_native (axi4_nativev)
@ axi_mm_wrapper : axi_mm_wrapper (axi_mm_wrapper.y)
@ axidmm_bridge : axidmm_bridge (axidmm_bridge v)
¥ IP-XACT (1)
> Constraints
> Simulation Sources (1)

e 1 T =4
Hierarchy  Libraries Compile Crder

Figure 1:Design sources where SD host netlist is instantiated

Module sd_host_controller is the top module of the project which integrates the all the other files

(as shown in the Figure 1) to form a single IP.
Once the IP is generated make sure that the IP needs to be added in the block design of the

Vivado project 2020.1.
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Figure 2:SD Host Controller added to the block design
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2.3

Steps to Instantiate SD HOST IP

Install the required Vivado Design Suite 2020.1 for the host PC adding the license path.
https://www.xilinx.com/support/download/index.html/content/xil%09%09inx/en/downlo
adNav/vivado-design-tools/archive.html

Copy the project from “...\EMFEV_Release1.0_SD_3.0_Host\iW-EMFEV-PF-01-R1.0-
REL1.0\iW-EMFEV-FF-01-R1.0-REL1.0\iW-EMFEV-ED-01-R1.0-REL1.0\
iW_EMFEV_REL_1.0\project_1” to your project directory in the host PC.

Open the Xilinx Vivado tool 2020.1 and click on “Open Project” and select the required
project from the folder by clicking ok.

Now the project selected will be opened in Vivado Design Suite 2020.1.

Go to settings of Vivado 2020.1 and add the IP to the Project Settings = IP >
Repository—>then add the IP  path .

” Settings >
IP > Repository
Project Settings Add directories to the list of repositories. You may then add additional IP to a '
Ceneral selected repository. If an IP is disabled then a tooltip will alert you to the reason
Simulation
Elaboration IP Repositories
Synthesis
+
Implementation
Bitstream Add
~ P
Mo content
Repository
FPackager
Tool Settings Refresh All
Project
IP Defaults
» XHub Store
Source File
Display
WebTalk
Help
» Text Editor
3rd Party Simulatars
> Colors
Selection Rules
Shortcuts
> Strategies
> Window Behavior
=
(o | [ mw ] [rewee

Figure 3:Adding SD_Host_controller IP to the IP repository

IP location is .\EMFEV_Releasel.0_SD 3.0 _Host\iW-EMFEV-PF-01-R1.0-REL1.0\iW-
EMFEV-FF-01-R1.0-REL1.0\iW-EMFEV-ED-01-R1.0-REL1.0\ iW_EMFEV_REL_1.0\
project_1.srcs \sources_1 \IP .Add IP by clicking on the + sign as shown in Figure 3. After
the IP is added click on Apply and close the dialogue box

Once the IP is added in the project repository open the block design by clicking on mb
_preset under top_module ->mb_preset_wrapper present in the source tab .

After adding the other IPs like Microblaze ,UART ,MIG Controller and Clocking
Wizard, add the SD host controller IP to the block design as shown in Figure 2 by
clicking on the + sign

iWave Systems Technologies Pvt. Ltd. Page 8 of 22
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2. Synthesize the block design first by validating the design(F6) and generate the output
products by right clicking on mb_preset under top_module >mb_preset_wrapper
present in the source tab and create HDL Wrapper

3. Instantiate mb_preset_wrapper in the top module with the ports and signals of block
design, in the top_module.v file as shown in Figure 4

SD/SDIO Host Controller IP Integration Manual

mb_presst_wrapper design_inst

moTaS T

.reset

.ddr3 sdram addr
.ddr3 sdram ba
.ddr3 sdram cas n
.ddr3 _sdram ck n
.ddr3 sdram ck_p
.ddr3_sdram cke
.ddr3_sdram cs_n
.ddr3_sdram dm
.ddr3 sdram dg
.ddr3 sdram dgs n
.ddr3 sdram dgs p
.ddr3 sdram odt
.ddr3_sdram ras_n
.ddr3_sdram reset n
.ddr3_sdram we n

LI3232_uart_rxd
L3232 _uart_txd

.2nakle o
amc_cd n i
mmc_clk_o
.mmc_dat_io
LImMC_ WP n i

.datal_dir o
.datal_3_dir o

{
{
{
{
{
{
{
{
{
{
{
{
{
{
{
{

!reset

ddr3 sdram addr
ddr3_sdram ba
ddr3_ sdram cas n
ddr3_sdram ck n
ddr3 sdram ck p
ddr3_sdram cke
ddr3_sdram cs_n
ddr3_sdram dm
ddr3_ sdram dg
ddr3_sdram dgs n
ddr3_ sdram dgs p
ddr3 sdram odt
ddr3_sdram ras_n

ddr3_sdram reset_n

ddr3_sdram we n

r3232_uart_rxd
r3232_uart_txd

enable o
mmc_cd n i
mmc_clk o
mmc_dat_io
Imc_Wp n i

.cind dir o cmd dir o
.cmd_in cmd _in
.cind_out cmd _out

datal_dir o
datal_3_dir_o

.3y3_diff clock clk n ays_diff clock clk n
.3ys_diff clock clk p

.voltage 1 & slct o

ays_diff clock clk p
voltage 1 & slct o

e T e B e T e T e B e T i T e T e B T

Figure 4:Instantiation of block design 10 signals in the top module

4. The Constraint file (.xdc) provided in the design is for the Xilinx KC705 Board. It
should be changed for custom boards other than Xilinx KC705 Board.

5. Give the required clock, Pin/IO constraints for SD host controller in the .xdc file and
compile the custom design with SD host IP.

iWave Systems Technologies Pvt. Ltd.
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3 Implementation Details

3.1 Clock Domain

SD Host Controller 3.0 IP works on the SDR104 mode and the base clock mclk_i drives the
output clock to the SD card. User may need to adjust this clock between 104 MHz to 208 MHz
based on the hardware setup. In other words, if user gets CRC error with say 200 MHz, then user
can reduce the clock to say 190 MHz or below than to make sure write and read works fine with
that base clock.

mclk90_i is a phase shifted version of the mclk_i which is 200MHz and this clock is phase
shifted based on the response from the SD card. By default, no phase shift is will be added..
Idelay_ref clk_i is the fixed 200 MHz clock which will be provided for the IDELAY primitive
to be used for the tuning implementation block.

s_axi_clk_i or hclk_i which is 100 MHz which will be used for the communication between the
micro blaze and IP using the AXI4-lite interface for register access and AXI4-MM for DMA
access.

So to generate the all these clocks we give a 200MHz on board clock to MIG controller and 100
MHz is generated from the MIG and that is given to the clocking wizard to generate other
required clocks.

3.2 Constraints

3.2.1 Clock constraints:

The figure 5 shows the clock constraints used in this design. The constraints given here is
the system clock whose frequency is 200Mhz for Xilinx KC705 board.

This constraint is added in the .xdc file. All other generated clocks will be automatically
handled by the Vivado tool since those are derived from the MMCM and will have
known relationship. User need to make sure there is no unconstrained clock in the design
by checking the clock network report in the Open implemented design from Vivado tool.

create clock -pericd 5.000 [get ports sys_diff cleck clk p]

Figure 5:Clock constraints
3.2.2 False path constraints:

The Figure 6 shows the false path in between all the clocks which is configured for the
SD host IP. This details will be available in the .xdc file.

set false path -from [get clocks -of objects [get pins desiqn nst/mb preser i/clk wis 0/ingt/men adv nst/CLEOIT2]] -to [get clocks -of objects [get pins deaign inst/mb prese i/clk wiz 0/inst/men adv nst/CLEOUTL]
set false path -ron [get pins desiqn Inst/b preset i/sd fost controller Ofinst/ad host ingt/ratall n 27 reg/C) -to [get ping design inst/ub preset 1/sd host controller 0/inst/sd host inst/taning block inst/IDIRE mo cud iddr inst/R]

Figure 6:False path constraints

iWave Systems Technologies Pvt. Ltd. Page 10 of 22
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3.2.3 LOC Constraints :

The Figure 7 shows the LOC constraints that is been added to the sd_host’s idelaycntrl.
Note that this LOC constraint is added because of the MIG GUI 7series idelaycntrl for
Xilinx KC705 board was conflicting with idelaycntrl of the SD_Host_Controller IP.

, set_property LOC IDELAYCTRL X1Y1 [get cells design inst/mb presst i/ad host controller 0/inst/sd host_inst/tuning bleck inst/IdelayCtl]

3.24

set property
set property
set property
set property
set property
set property
set property
set property
set property
set property
set property
set_property
'+ set property

E set property
. set property
| set_property
E set property
. set_property
set property
set property
set property
set property
set property
set property
set property
set property

Pin Constraints:
Figure 8 shows the pin constraints in the .xdc file of example design.

PACERGE FIN
BACERGE FPIN
PRCERGE FIN
PACERGE FIN
PRCERGE PIN
FRCERGE FIN
PRACERGE FIN
PACERGE FIN
PRCERGE FIN
PRCERGE FIN
PACERGE FIN
PRCERGE PIN
FRCERGE FIN

IOSTANDRRD
IOSTANDRARD
IOSTANDARD
IOSTANDRRD
IOSTANDRRD
IOSTANDARD
IOSTANDARD
IOSTANDRRD
IOSTANDRARD
IOSTANDARD
IOSTANDRRD
IOSTANDRRD
IOSTANDARD

Figure 8:Pin Constraints in example design .xdc file

H2&
E2%
G238
D24
Hz24
E23
G27
C249
G249
B30
H30
30
D11

LVCMOS51E
LVCMOS51E
LVCMO518
LVCMOS18
LVCMOS1E
LVCMO513
LVCMO518
LVCMOS51E
LVCMOS51E
LVCMO518
LVCMOS18
LVCMOS1E
LVCMO513

Figure 7:LOC Constraints

[get_ports
[get_ports
[get ports
[get_ports
[get ports
[get ports
[get_ports
[get_ports
[get ports
[get ports
[get_ports
[get_ports
[get ports

{mmc_dat_io[3]}]
{mmc_dat ic[2]}]
{mmc_dat_io[l]}]
{mmc_dat_io[0]}]
mmc_clk o]
mmc_cmd_io]
datal_dir_o]
datal_3_dir o]
cmd_dir_ o]
wvoltage_1_8 slct_o]
mmc_cd n i]
mmc_Wp n i]
enable o]

[get ports [mmc_dat_ic[3]}]
[get ports {mmc dat ic[2]]]
[get ports {mmc_dat_ic[l]}]
[get_ports [mmc_dat_io[0]}]]
[get_ports
[get ports
[get ports
[get_ports
[get ports
[get ports
[get ports
[get_ports
[get ports

mmc_clk o]
mmc_cmd io]
datal_dir_o]
datal_3_dir o]
cmd_dir o]

mmc_cd n i)
mmc Wp noi]
enable_ o]

voltage 1_& slct_o]

NOTE: These constraints are in accordance to example design created for the KC705
Evaluation kit and there is no need of adding the MIG/ DDR 10 pins, UART 10 pins .
Define the constraints for clock, reset and UART pins accordingly for any other custom

board.

iWave Systems Technologies Pvt. Ltd.
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4 Test setup

4.1 Test requirements

Xilinx KC705 dev kit

iIWave FMC daughter card

USB cables for JTAG and UART
SD card for testing

Power Supply 12 V

NOTE: iWave FMC card requires Vadj=1.8V for its operation. In order to set Vagj to 1.8V,
rework needs to be done in Xilinx KC705 board as its Vadgj =2.5v by default. User need to
do below rework,

e Remove resistor R576
e Removed inductor L47

The Vagj value depends on the custom board and this rework is only needed for testing
iWave FMC daughter card with KC705 dev Kit.

4.2 Connections

N
)

I

Figure 9:Test Setup of KC705 board with iw_FMC card

iWave Systems Technologies Pvt. Ltd. Page 12 of 22
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Please make sure that FMC card of SD connector interface is connected to HPC FMC of
Xilinx KC705 board. Also make sure that SD connector FMC card is set to 1.8V and 2
Blue LED in FMC card is glowing as shown in the Figure 10.

Figure 10:SD Connector FMC

4.3 Programming FPGA and running using Vitis.

e After generating bitstream in Vivado 2020.1 go to File> Export hardware - select
Fixed click next = select include bitstream and click next - give the XSA file name
where you want to store your xsa and keep directory as local to project and click Finish

e Create a local folder in the Vivado Project folder and give that as workspace folder for
Vitis 2020.1 project and click ok

e After exporting the project go to tools in Vivado and give the path of the local folder
created as a workspace folder for Vitis (mentioned in step 2), click on launch Vitis IDE
as shown in Figure 11 a new window will appear

iWave Systems Technologies Pvt. Ltd. Page 13 of 22
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«J Eclipse Launcher *

Select a directory as workspace

Vitis IDE uses the workspace directory to store its preferences and development artifacts.

Workspace: | F\Projects\ivy_EMFEV_REL_1.00SW_FPGA “ Browse...

[] Use this as the default and do not ask again
b Restore other Workspace

b Recent Workspaces

Figure 11:Launching Vitis 2020.1

e Once Vitis 2020.1 is opened then click on creates new application project and click on
Create a new platform file >give the .xsa file path by browsing to that file where you
had exported your xsa (project local folder)and click next ,give application project name
and click next

e In Available templates click on empty project and click on finish

e Once the project is open, copy the source code from the release folder
(\EMFEV_Releasel.0_SD_3.0_Host\iW-EMFEV-PF-01-R1.0-REL1.0\iW-EMFEV-SF-
01-R1.0-REL1.0\iW-EMFEY-SC-01-R1.0-REL1.0\iW_EMFEV_SD_HOST _vitis_REL
_1.0\sd_host_test\src) to Vitis project src folder and then Save (CTRL+S) and
Build(CTRL+B) the project
NOTE: Copy only iwsd_hardware.h, iwsd_host_controller.h, iwsd_host_controller.c and
main.c from the release folder to the src folder present under the application project.

e Then right click on project go to run and click run configuration ->system project debug

e In the appeared window under target setup click on reset entire system and program
FPGA as shown in the Figure 12

iWave Systems Technologies Pvt. Ltd. Page 14 of 22
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3] s ot st sy [ top.m| ™ P Configunations
test

| Craate, manage, and run configurations

ey i Vi Debunger o

X[B®- Hame [ SystemDebugger sd_host test_system

5 sd_host_testpr | Main [@ Target Setup B Emyi
ide v &, System Project Debu
L, systembDebugger_sd_host_test_system

Harduware Platforms: | S{scs efLaunchFile fieTypes v Search.. Browse...

10p.7

u

u

u

u

u

u

u

u

u

. HECK

= = ®  PATIERN_CHECK

FPGA Device: Auto Detect Select... ® WIDTH_SUPPORT 4

® CARD REMOVED

® waoe

® PREVIOUS DAT:
S Reset entire system s our

2

"

M

M

#

9 Program FRGA
[ Skip Revion Che

Filter matched 2 of 2 tems

[ [PrTep—

Figure 12:Target setup in run configuration.

e Now click on Run
e After clicking on Run, FPGA will be programmed and board is test ready.

NOTE: Before clicking on Run please make sure Xilinx KC705 board is turned on with
JTAG connections, 12V power supply and proper tera term setup.

If program FPGA is done using Vivado 2020.1 please don’t select program FPGA option in
target setup Vitis 2020.1.
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5 Test Procedure

5.1 Tera term setup

e Open tera term in PC and select the com port other than COM1 (File> New
connection > Serial).

e Select baud rate as 115200 in setup —>serial port > Speed .

5.2 Testing Procedure
After set up follow the below procedure to test the SD Host controller IP.

5.2.1 Initial prints:

Make the necessary connection to program the target FPGA board. Connect UART and

JTAG along with FMC Card of SD Connector interface to target FPGA board as shown

in the Figure 9 and do the Proper tera term setup.

After clicking on Run in Run configuration ,software will program the FPGA. Once the

programming is done and .elf file is executed, then below print will be displayed in Tera
term. Please wait for some time for the initial prints to be displayed.

M COM3:115200baud - Tera Term VT — O s
File Edit Setup Control Window Help

Welcome To iWave Demo Of SD Host Controller 3.8

Card Removed???

Waiting For Card To Be Inserted

Figure 13:Initial print after FPGA is programmed

As shown in the Figure 13 the application is waiting for the card to be Inserted , so insert
the card and then the check that the D5 Red led on the FMC card is glowing which
indicates that SD card is detected refer Figure 14, if that is glowing then the following
prints will come as shown in Figure 15

Figure 14:Card Inserted to FMC

iWave Systems Technologies Pvt. Ltd. Page 16 of 22
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COM35:115200baud - Tera Term VT — O =
File Edit Setup Controel Window Help

Welcome To iWave Demo Of S Host Controller 3.8

Card Removed?*t?
Waiting For GCard To Be Inserted

Card Inserted

Driver version = 3

1864585824
1396987185
538984709

2975408247

CardIDL3]
CardIDL2]
CardIDIL1]
CardIDILBA]

card_size in Ghytes = 38 GB

8D initialization Successful?

SCR_STRUCTURE =
SCR_SD_SPEC
SCR_DATA_STAT_AFTER_ERASE
SCR_SECURITY
SCR_SD_BUS_MIDIHS

Card Supports 1 bit and 4

[ -]
L mba

-2
=]

ot
=

h
-1
I
=

Data Width 3elected : 2

Card Supports SDR164 Mode
Getting bus speed pass?
Data transfer initiated at SDR184 Mode

Tuning_regB: 4886
Tuning_regl: 4294959104

Initial Reading from card

Total Block count is: 51288

Multi block BRead during Initiali=ation passed*t*®*?

Enter the following choice as needed and press enter:

1 —» Basic UWrite Operation.

2 —>» Basic Read Operation.

3 —> Write and Read and compare internally and display the result az MATCHED or
NOT Matched.

Figure 15:Card Initialization

As shown in the Figure 15 test case is available i.e.
1. Basic Write Operation
2. Basic Read Operation
3. Write and Read and compare internally and display the result as Matched or Not
Matched
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4. Any other test case than the mentioned above will result in wrong choice i.e.”
NOT Matched” as shown in Figure 16.

Enter the following choice as needed and press enter:

1 -» Basic Weite Operation.

2 —-» Bazic Read Operation.

3 - Write and Read and compare internally and display the result as MATCHED op
NOT Matched.

Entered Choice : 4

Select a valid option

Enter the following choice as needed and press enter:

1 -» Bagic Weite Operation.

2 —-» Basic Read Operation.

3 -> Write and Read and compare internally and display the result as MATCHED o
NOT Matched.

Figure 16:Wrong choice

5.2.2 Basic Write Operation:

e Basic write operation is the 1% testcase in the current design

e After initial prints, press “1” and then enter the pattern enter “1” for Incremental
pattern and enter “2” for Toggling pattern

e Once pattern is selected then enter the block count with minimum value of “1”
and maximum value of “1024”

e Enter the block count and the enter the Start address, once the operation is
completed successfully then user get the print “Write Completed”

Enter the following choice as needed and press enter:

1 -> Basic UWrite Operation.

2 -» Basic Read Operation.

3 - Write and Read and compare internally and display the result as MATCHED o
NOT Matched.

Entered Choice : 1

Enter the pattern and press enter:
1 -> Incremental Pattern

2 - Toggling Pattern

Pattern Entered : 1

Enter the hlock count value hetween 1 and 1824 inclusive.
Enter 1 for single hlock write.

Enter value greater than 1 for multiple hlock write.

Block Count Entered : 512

Address in decimal address
Start Address Entered : 1608

Total Block count is: 262144
Write Completed

Enter the following choice as needed and press enter:

1 -» Basic Write Operation.

2 -» Basic Read Operation.

3 - Write and Read and compare internally and display the result as MATCHED o
NOT Matched.

Figure 17:Basic Write Operation
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5.2.3 Basic Read Operation:

e After initial prints, press “2” for basic Read Operation and then enter the block
count with minimum value of “1” and maximum value of “1024”

e Enter the block count and the enter the Start address from where the read
operation needs to be started, once the read operation is completed successfully
then user get the print “Read Completed.”

Enter the following choice as needed and press entep:

1 —-» Basic Write Operation.

2 —» Basic Read Operation.

3 —» Write and Read and compare internally and display the result as MATCHED
NOT Matched.

Entered Choice : 2

Enter the block count value between 1 and 1824 inclusive.
Enter 1 for single block read.

Enter value greater than 1 for multiple block read.

Block Count Entered : 512

Enter the starting address <8 to 3129343%9>.

Address in decimal
Start Address Entered : 180688

Total Block count is: 262144

Read Completed

Enter the following choice as needed and press enter:

1 —-» Basic Write Operation.

2 —» Basic Read Operation.

3 —» Write and Read and compare internally and display the result as MATCHED
NOT Matched.

Figure 18:Basic Read Operation

5.2.4 Write, Read and Compare operation:

e The 3" test case is Write and read back and compare and display whether it’s a
match or not match .

e After initial prints, press “3” and then enter the pattern enter “1” for Incremental
pattern and enter “2”for Toggling pattern.

e Once pattern is selected then enter the block count where the minimum value is
“1” and maximum value is “1024” enter the block count and then enter the Start
address of the write and read operation to start.

e Once the address is entered the Write to Card Operation will start and once the
operation is completed successfully then user get the print “Write Completed,”
then Read from Card operation will start and print will be obtained same as in
write operation .

e Write and read data is “Matched or Not Matched” print will be observed in the
Console.

iWave Systems Technologies Pvt. Ltd. Page 19 of 22
(Confidential)



L]
I Wave SD/SDIO Host Controller IP Integration Manual

Enter the following choice as needed and press entep:

1 -» Basic Write Operation.

2 —» Basic Read Operation.

3 —> Write and Read and compare internally and display the reszsult az MATCHED or
MOT Matched.

Entered Choice : 3

Enter the pattern and press enter:

1 -> Incremental Pattern

2 —» Toggling Pattern

Pattern Entered : 2

Enter the block count value between 1 and 1824 inclusive.
Enter 1 for single hlock write.

Enter value greater than 1 for multiple block write.
Block Count Entered @ 512

Enter the starting address (@ to 31293439>.

Address in decimal
Start Address Entered : 1884

Writing to card.
Total Block count is: 262144
Write Completed

Reading from the card.
Total Block count is: 262144

MATCHED
Read Completed

Enter the following choice as needed and press entep:

1 -» Basic Write Operation.

2 —» Basic Read Operation.

3 —» Write and Read and compare internally and display the rezsult az MATCHED or
HOT Matched.

Figure 19:Write & Read Back and Compare

NOTES:

e The current base clock is running at 200 MHz which is the maximum clock that can
be used with KC705 dev kit.

e Block count up to 1024 is supported.

iWave Systems Technologies Pvt. Ltd. Page 20 of 22
(Confidential)



l WHVC SD/SDIO Host Controller IP Integration Manual

6 Design modification to be done for Custom Board

Update the FPGA part number/board according to the FPGA device used

Update the complete design for the selected FPGA device

Update the pin constraints for SD interface, clock, reset and UART pins

Update the clock constraint according to the input clock frequency for the selected FPGA
device

e Recompile the design to generate the new binaries and use the XSA file to create the new
application project in Vitis
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7 Resource Utilization

The table below shows the resource utilization summary for KC705 dev. kit. for SD Host Controller
IP.

Table 2: Resource Utilization for device for KC705 dev. Kit.

Resource Utilization Available
LUT 1564 203800
FF 2154 407600
BRAM 1 445
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